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5. Functions

5.1.Introduction

A function is a predefined formula that performs calculations using specific values in a
particular order. Excel includes many common functions that can be used to quickly find the
sum, average, count, maximum value, and minimum value for a range of cells. In order to
use functions correctly, you'll need to understand the different parts of a function and how to
create arguments to calculate values and cell references.

5.1.1. The parts of a function

In order to work correctly, a function must be written a specific way, which is called the
syntax. The basic syntax for a function is the equals sign (=), the function name (SUM, for
example), and one or more arguments. Arguments contain the information you want to
calculate. The function in the example below would add the values of the cell range A1:A20.

Equals sign

|
=SUM(AT:A20)
(. ~ J \ ~ J
Function name Argument

5.1.2. Working with arguments

Arguments can refer to both individual cells and cell ranges and must be enclosed within
parentheses. You can include one argument or multiple arguments, depending on the syntax
required for the function.

For example, the function =AVERAGE(B1:B9) would calculate the average of the values in
the cell range B1:B9. This function contains only one argument.



METWORK... ™ x v k& =AVERAGE(B1:B9)

A B C D E

1 1
2 4
3 5
A 3]
5 8
B 2
7 3
g 5
g B
10 =AVERAGE(B1:B9)
11

Multiple arguments must be separated by a comma. For example, the function
=SUM(A1:A3, C1:C2, E1) will add the values of all of the cells in the three arguments.

AL w7 o W I =SUM({AL:A3,C1:C2,E1)
A B C D E F
1 4 6 | 20|
—
2 2 10
| | | |
3 12
1 | |
4 P———
5 |=SUM(A1:A3,C1:C2,E1)
G

5.2.Creating a function

There are a variety of functions available in Excel. Here are some of the most common
functions you'll use:

e SUM: This function adds all of the values of the cells in the argument.

o AVERAGE: This function determines the average of the values included in the
argument. It calculates the sum of the cells and then divides that value by the number
of cells in the argument.

e COUNT: This function counts the number of cells with numerical data in the
argument. This function is useful for quickly counting items in a cell range.

e MAX: This function determines the highest cell value included in the argument.

e MIN: This function determines the lowest cell value included in the argument.



5.2.1. To create a function using the AutoSum command:
The AutoSum command allows you to automatically insert the most common functions into
your formula, including SUM, AVERAGE, COUNT, MIN, and MAX. In the example below,

we'll use the SUM function to calculate the total cost for a list of recently ordered items.

1. Select the cell that will contain the function. In our example, we'll select cell D13.

D13 - I

3 [Tomatoes (case of 12) 3 $17.44 §52.32
4 |Black Beans (case of 10) 5 $20.14 $100.70
s |All Purpose Flour (50 Ib.) 5 $14.05 570.25
& [(Corn Meal/Maza (25 Ib.) 5 S18.69 S93.45
7 Brown Rice (25 |b.) 5 510.99 554.95
3 |Lime Juice (1 gallon) 5 $11.99 $59.95
g Tomato Juice (case of 10) 3 5$19.49 558.47
10 Hot Sauce (1 gallon) 8 57.35 S58.80
11| Salsa, Medium (1 gallon) 12 58.47 $101.64
12 Olive Qil (2.5 gallon) 4 $28.69 $114.76
13| op

14

2. In the Editing group on the Home tab, click the arrow next to the AutoSum
command. Next, choose the desired function from the drop-down menu. In our
example, we'll select Sum.

- _______________________________________
EED E)q il EAthSumEBw O

S
Insert Delete Format E =4 b'ld &L
M - - - Average
el Sum (Alt+=)
ells -

Count Numbers Automatically add it up. Your total
Max 3 will appear after the selected cells,

Min &

| O p 5

1 More Functions...
3
—suM()2:)5)

3. Excel will place the function in the cell and automatically select a cell range for the
argument. In our example, cells D3:D12 were selected automatically; their values will
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be added to calculate the total cost. If Excel selects the wrong cell range, you can
manually enter the desired cells into the argument.

NETWORK... ¥ | : | X « J | =5UM(D3:D12)
A A B T D
QUANTITY  UNIT PRICE LINE TOTAL O
3 | Tomatoes (case of 12) 3 $17.44 §52.32
4 |Black Beans (case of 10) 5 $20.14 $100.70
5 |All Purpose Flour (50 Ib.) 5 514.05 570.25
6 |Corn Meal/Maza (25 Ib.) 5 S18.69 S93.45
7 |Brown Rice (25 Ib.) 5 $10.99 $54.95
8 |Lime Juice (1 gallon) 5 $11.99 559.95
9 | Tomato Juice (case of 10) 3 $19.49 S58.47
10| Hot Sauce (1 gallon) 8 57.35 558.80
11 |Salsa, Medium (1 gallon) 12 S8.47 5101.64
12 Olive Qil (2.5 gallon) 4 $28.69 $114.76
13
14 SUM{number1, [number?], ...)

4. Press Enter on your keyboard. The function will be calculated, and the result will
appear in the cell. In our example, the sum of D3:D12 is $765.29.

D13 ~ F | =5UM(D3:D12)

A A B C D

8 ITEM QUANTITY  UNIT PRICE LINE TOTAL O
3 | Tomatoes (case of 12) 3 $17.44 $52.32
4 |Black Beans (case of 10) 5 $20.14 $100.70
5 |All Purpose Flour (50 Ib.) 5 $14.05 §70.25
6 |Corn Meal/Maza (25 Ib.) 5 $18.69 $93.45
7 |Brown Rice (25 Ib.) 5 $10.99 554.95
8 |Lime Juice (1 gallon) 5 $11.99 $59.95
9 | Tomato Juice (case of 10) 3 $19.49 558.47
10| Hot Sauce (1 gallon) 8 5$7.35 $58.80
11 |Salsa, Medium (1 gallon) 12 58.47 $101.64
12 Olive Qil (2.5 gallon) 4 528.69 5114.76
‘|i



The AutoSum command can also be accessed from the Formulas tab on the Ribbon.

Home Insert Page Layout Data Review View @ Tell me what you want

fx 2 E B E I! £y S Define Name

fr Use in Formu
Insert  |AutoSum Recently Financial Logical Text Date & Lookup & Math&  Mare Mame
Function - Used - - - ~  Time~ Reference~ Trig~ Functions~ Wanager £ Create from ¢
z Sum Function Library Defined Names

D13 Average fe | =SUM(D3:D12)

Count Mumbers

B = D

Max | |
2 1 Min |
3 |[Tom More Eunctions... 3 517.44 552.32
4 |Black Beans (case of 10) 5 520.14 $100.70

You can also use the Alt+= keyboard shortcut instead of the AutoSum command. To use this
shortcut, hold down the Alt key and then press the equals sign.

Watch the video below to see this shortcut in action.

5.3.To enter a function manually:

If you already know the function name, you can easily type it yourself. In the example below
(a tally of cookie sales), we'll use the AVERAGE function to calculate the average number
of units sold by each troop.

1. Select the cell that will contain the function. In our example, we'll select cell C10.

C10 v I
A B C
1 Frontier Kids Cookie Sales
5 Troop Name Troop 1D Units Sold
3 North Bend #3506 1004
4 Silver Lake #2745 938
5 | Mountain Top #1038 745
s Rocky Trail #3759 729
7 Forest Path #4157 862
8 | Green Valley #1932 890
g River View #4233 775
. Average Units oo
1




2. Type the equals sign (=), and enter the desired function name. You can also select
the desired function from the list of suggested functions that appears below the cell
as you type. In our example, we'll type =AVERAGE.

NETWORK... ~ xX v K =AVERAGE
A B C
1 Frontier Kids Cookie Sales
5 Troop Name Troop D Units Sold
3 North Bend #3506 1004
4 | Silver Lake #2745 038
5 | Mountain Top #1038 745
6 Rocky Trail #3759 729
7 Forest Path #4157 862
g | Green Valley #1932 690
g River View #4233 775
10 Average Units =AVERAGE
= Returns the aver
11 'jﬁ’:' contain number
| () AVERAGEA
12 | () AVERAGEIF
13 () AVERAGEIFS
14

3. Enter the cell range for the argument inside parentheses. In our example, we'll type
(C3:C9). This formula will add the values of cells C3:C9, then divide that value by
the total number of values in the range.

c10 - X « Jfr | =AVERAGE(C3:C9)
A B C
j Frontier Kids Cookie Sales
, |Troop Name Troop 1D Units Sold
3 |North Bend #3506 1004
4 |Silver Lake #2745 938
5 | Mountain Top #1038 745
6 |Rocky Trail #3759 729
7 |Forest Path #4157 862
8 | Green Valley #1932 890
g |River View #4233 75
10 Average Units =AVERAGE(C3:C9)
11




4. Press Enter on your keyboard. The function will be calculated, and the result will
appear in the cell. In our example, the average number of units sold by each troop is

849.
C10 v fe | =AVERAGE(C3:C9)
A B C
1 Frontier Kids Cookie Sales
5 Troop Name Troop D Units Sold
3 |North Bend #3506 1004
4 | Silver Lake #2745 938
5 | Mountain Top #1038 745
6 |Rocky Trail #3709 729
7 |Forest Path #4157 862
g | Green Valley #1932 690
g |River View #4233 775
10 Average Units 649
1

Excel will not always tell you if your formula contains an error, so it's up to you to check all
of your formulas.



5.4.The Function Library

While there are hundreds of functions in Excel, the ones you'll use the most will depend on
the type of data your workbooks contain. There's no need to learn every single function, but
exploring some of the different types of functions will help you as you create new projects.
You can even use the Function Library on the Formulas tab to browse functions by
category, such as Financial, Logical, Text, and Date & Time.

To access the Function Library, select the Formulas tab on the Ribbon. Look for the
Function Library group.

Click the buttons in the interactive below to learn more about the different types of functions
in Excel.

Horme Insert Page Layout Farrmulas Data Review View Q Tell me what you want to do...
fx z IE B IE éx\li =] Define Name -
T — Use in Farmula
Insert  AutoSum Recently Financial Logical Text Date & Lookup & Math&  Maore MName
Function - Used - - M ~  Time~ Reference~ Trig~ Functions~ Manager £ Create from Selection
Function Library Defined Mames
R28 i F
A B C D E F G H | J K
1
2
2
4
3
&
T
8
g
10

5.4.1. To insert a function from the Function Library:

In the example below, we'll use the COUNTA function to count the total number of items in
the Items column. Unlike COUNT, COUNTA can be used to tally cells that contain data of
any kind, not just numerical data.

1. Select the cell that will contain the function. In our example, we'll select cell B17.

10



A A B c D
P ITEM QUANTITY  UNIT PRICE LINE TOTAL
3 ' Tomatoes (case of 12) 3 $17.44 $52.32
4 |Black Beans (case of 10) 5 $20.14 $100.70
s |All Purpose Flour (50 Ib.) 5 $14.05 $70.25
6 Corn Meal/Maza (25 Ib.) 5 $18.69 $93.45
7 |Brown Rice (25 Ib.) 5 $10.99 $54.95
8 Lime Juice (1 gallon) 5 $11.99 $59.95
s |Tomato Juice (case of 10) 3 $19.49 $58.47
10 Hot Sauce (1 gallon) 3 $7.35 $58.80
11 Salsa, Medium (1 gallon) 12 $8.47 5101.64
12| Olive Oil (2.5 gallon) 4 $28.69 $114.76

13 TOTAL $765.29

oty PURCHASE ORDER SUMMARY
17| Total items ordered

18 | Most expensive item
Average days in transit

19

?_o‘

2. Click the Formulas tab on the Ribbon to access the Function Library.
3. From the Function Library group, select the desired function category. In our
example, we'll choose More Functions, then hover the mouse over Statistical.

11



Page Layout Formulas

(1] S Define Mame - E':“ Trace Prece
B 3D E ] BfEy S :
ame

i S . N %7l Use in Formula ol Trace Depe
- Gg* ~  Time~ Referenpv:l:e' Trig ~ JFunctions ~ | Manager [5 Create from Selection I3 Remove Ar

Function Library I, Statistical 4 | AVEDEY E

Il Engineering "~ * AVERAGE

| I%, Cube g AVERAGEA '
B C _ F
[P Compatibility » AVERAGEIFS -4
of 12) 3 S1 P web v BETA.DIST ]
=2 of 10) 5 520.14 S10 BETA.INV 1
r (50 1h.) 5 514.05 S7 BINOM.DIST 1
(25 1b.) 5 $18.69 g9  BINOMDBT.RANGE 1
b.) 5 $10.99 gg  EhoMImv 1
CHISQ.DIST i
lon) 5 511.99 S5 CHISQLDIST AT 2
15e Df 10} 3 51949 55 CHISOLIMNY ]
lon) 8 57.35 S5 CHISQINV.RT z
1 gallon) 12 58.47 510 CHISQ.TEST 2
|Dn} 4 52869 511 COMFIDEMCE.NORM ;

— $76 COMFIDENCE.T
CORREL

Select the desired function from the drop-down menu. In our example, we'll select
the COUNTA function, which will count the number of cells in the Items column
that are not empty.

12



Page Layout

=g 12 AL s < B O -

Financial Logical Text Date& Lookup & Math &  Mare

- - -

Function Library

mﬂ C.

of 12)

=2 of 10)
r (50 1h.)
(25 1b.)
b.)

lon)

1se of 10)
lon)

1 gallon)
lon)

Formulas

Data

Review View

Define Mame =

W
= _,_ﬁ'; Use in Formula
Time~ Reference~ Trig~ Functions~ Mr::;ngeer [ Create from Selection
I, Statistical k COMFIDEMNCE.NORM
IR Engineering » CONFIDENCE.T
IR, Cube ’ CORREL
@ Information  » COUNT
[P Compatibility » COUNTA |}
3 PIIR we ' COUNTA(value1,value2.)
> 52D14 SlD Counts the number of cellsin a
5 514[}5 5? range that are not empty.
5 518.69 S9 | @ Tellmemore
5 5 ]_D 99 55 COVARIANTCE.S
DEVSQ
> $11.99 55 EXPON.DIST
3 519.49 S5 F.DIST
8 57.35 S5 F.DIST.RT
12 58.47 510 FINV
4 $28.69 S11  RWRT
Ry
FISHER

5. The Function Arguments dialog box will appear. Select the Valuel field, then enter
or select the desired cells. In our example, we'll enter the cell range A3:A12. You may
continue to add arguments in the Value2 field, but in this case we only want to count
the number of cells in the cell range A3:A12.

6. When you're satisfied, click OK.

13
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Function Arguments ? >

COUNTA

Valuel |A3:A12 {"Tomatoes (case of 12)""Black Bean...

Value2 | number

10

Counts the number of cells in a range that are not empty.

Valuel: valuelwvalue2,... are 110 255 arguments representing the values and cells
you want to count. Values can be any type of information.

Formula result = 10

Help on this function | oK !}J | Cancel |

7. The function will be calculated, and the result will appear in the cell. In our example,

the result shows that a total of 10 items were ordered.

B17 | £ [ =COUNTA(A3:A12)

4 A B c D
e ITEM QUANTITY  UNIT PRICE LINE TOTAL
3 |\ Tomatoes (case of 12) 3 $17.44 $52.32
4 |Black Beans (case of 10) 5 $20.14 $100.70
5 |All Purpose Flour (50 Ib.) 5 $14.05 $70.25
6 Corn Meal/Maza (25 Ib.) 5 $18.69 $93.45
7 | Brown Rice (25 Ib.) 5 $10.99 $54.95
8 |Lime Juice (1 gallon) 5 $11.99 $59.95
9 |\ Tomato Juice (case of 10) 3 $19.49 $58.47
10 Hot Sauce (1 gallon) 3 §7.35 $58.80
11 Salsa, Medium (1 gallon) 12 $8.47 $101.64
12| Olive Qil (2.5 gallon) 4 $28.69 $114.76
14

15

' PURCHASE ORDER SUMMARY
17 | Total items ordered

18 |Most expensive item
19 Average days in transit

20

14



5.5.The Insert Function command

While the Function Library is a great place to browse for functions, sometimes you may
prefer to search for one instead. You can do so using the Insert Function command. It may
take some trial and error depending on the type of function you're looking for; however, with
practice, the Insert Function command can be a powerful way to find a function quickly.

5.5.1. To use the Insert Function command:
In the example below, we want to find a function that will calculate the number of business
days it took to receive items after they were ordered. We'll use the dates in columns E and F

to calculate the delivery time in column G.

1. Select the cell that will contain the function. In our example, we'll select cell G3.

G3 = Je
A E F G H
2
3 |Tomatoes (case of 12) 12-Oct 15-Oct o
4 |Black Beans (case of 10) 12-Oct 17-Oct
5 All Purpose Flour (50 Ib.) 12-Oct 14-Oct
6 (Corn Meal/Maza (25 Ib.) 12-Oct 15-Oct
7 \Brown Rice (25 Ib.) 12-Oct 15-Oct
8 |Lime Juice (1 gallon) 16-Oct 20-Oct
g 'Tomato Juice (case of 10) 16-Oct 19-Oct
10 Hot Sauce (1 gallon) 16-Oct 20-Oct
11 Salsa, Medium (1 gallon) 19-Oct 23-Oct
12 Olive Qil (2.5 gallon) 19-Oct 24-Oct
13

2. Click the Formulas tab on the Ribbon, then click the Insert Function command.

Home Insert Page Layout Formulas Data Review View Q@ Tell me what you want to do.,
= Define Mame -
Ko 2 B EEETE R B —
l:? . . . o “fx Use in Formula
Insert ~ AutoSum Recently Financial Logical Text Date & Lookup & Math &  Mare MName )
Function - Used ~ - - - Time~ Reference~ Trig~ Functions~ Manager £ Create from Selectio
Function Library Defined Mames

Insert Function (Shift+F3) P

Work with the formula in the
current cell. You can easily pick E F G H
functions to use and get help on
how ta fill out the input values.

a Tell me more 12—0Ct 15_0Ct
4 |Black Beans (case of 10) 12-Oct 17-Oct

15



[98)

The Insert Function dialog box will appear.

Type a few keywords describing the calculation you want the function to perform,
then click Go. In our example, we'll type count days, but you can also search by
selecting a category from the drop-down list.

Insert Function ? >

Search for a function:

Or select a category: | All

Select a function:

ABS A
ACCRINT

ACCRINTM

ACOS

ACOSH

ACOT

ACOTH e

ABS({number)
Returns the absolute value of a number, a number without its sign.

Help on this function | OK | | Cancel

Review the results to find the desired function, then click OK. In our example, we'll
choose NETWORKDAYS, which will count the number of business days between
the ordered date and received date.

Insert Function ? >

Search for a function:

count days o

Or select a categorny: | Recommended

Select a function:

MINWVERSE
MMULT
METWORKDAYS.IMTL

CODDFPRICE

WORKDAYS(Start_date,end_date, holiday

Returns the number of whole workdays between two dates.

Help on this funcion | QK [}J | Cancel

16



6. The Function Arguments dialog box will appear. From here, you'll be able to enter
or select the cells that will make up the arguments in the function. In our example,
we'll enter E3 in the Start_date field and F3 in the End_date field.

7. When you're satisfied, click OK.

Function Arguments ? >
METWORKDAYS
Start_date | E3 ERs| = 42289
End_date | F3 ERz| = 42292
Holidays FRz| =
= 4

Returns the number of whole workdays between two dates.

End_date is a serial date number that represents the end date.

Formula result = 4

Help on this fundion Cancel

8. The function will be calculated, and the result will appear in the cell. In our example,
the result shows that it took four business days to receive the order.

G3 - I =NETWORKDAYS(E3,F3)
A E F G
2
3 |Tomatoes (case of 12) 12-Oct 15-Oct 4
4 |Black Beans (case of 10) 12-Oct 17-Oct
s All Purpose Flour (50 Ib.) 12-Oct 14-Oct
6 Corn Meal/Maza (25 Ib.) 12-Oct 15-Oct
7 \Brown Rice (25 Ib.) 12-Oct 15-Oct
8 |Lime Juice (1 gallon) 16-Oct 20-Oct
o 'Tomato Juice (case of 10) 16-Oct 19-Oct
10 Hot Sauce (1 gallon) 16-Oct 20-Oct
11 Salsa, Medium (1 gallon) 19-Oct 23-Oct
12 Olive Qil (2.5 gallon) 19-Oct 24-Oct
13

Like formulas, functions can be copied to adjacent cells. Simply select the cell that contains
the function, then click and drag the fill handle over the cells you want to fill. The function
will be copied, and values for those cells will be calculated relative to their rows or columns.

17
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Tomatoes (case of 12)
Black Beans (case of 10)
All Purpose Flour (50 Ib.)
Corn Meal/Maza (25 Ib.)
Brown Rice (25 Ib.)

Lime Juice (1 gallon)
Tomato Juice (case of 10)
Hot Sauce (1 gallon)
Salsa, Medium (1 gallon)
Olive Oil (2.5 gallon)

=NETWORKDAYS(E3,F3)

ORDERED

12-Oct
12-Oct
12-Oct
12-Oct
16-Oct
16-Oct
16-Oct
19-Oct
19-Oct

18
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